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2 Haftungsausschluss 

Dieses Produkt (bzw. Dokument) steht Ihnen in der aktuellen Version „WIE BESEHEN - ohne 
Gewährleistung“ zur Verfügung. TEC-IT weist alle Garantien, die über das anwendbare Recht 
hinausgehen, zurück. Risiken, die aus der Benutzung des Produkts und der Dokumentation 
entstehen, trägt der Lizenznehmer bzw. Benutzer. TEC-IT und seine Vertragspartner dürfen nicht 
für direkte oder indirekte Schäden oder Verluste belangt werden (dies beinhaltet, uneingeschränkt, 
Schäden durch den Verlust von Einkünften, Einschränkungen in der Geschäftsausübung, Verlust 
von Geschäftsinformationen sowie andere wirtschaftliche Verluste), die aus der Benutzung oder 
Unfähigkeit zur Benutzung des Produkts (der Dokumentation) entstanden sind, selbst wenn TEC-IT 
auf die Möglichkeit solcher Schäden hingewiesen hat. 

 

 
We reserve all rights to this document and the information contained therein. Reproduction, 
use or disclosure to third parties without express authority is strictly forbidden. 
 

 Für dieses Dokument und den darin dargestellten Gegenstand behalten wir uns alle Rechte 
vor. Vervielfältigung, Bekanntgabe an Dritte oder Verwendung außerhalb des vereinbarten 
Zweckes sind nicht gestattet. 
 

© 1998-2006  
TEC-IT Datenverarbeitung GmbH  
Wagnerstr. 6 

A-4400 Austria  
t.: +43 (0)7252 72720  
f.: +43 (0)7252 72720 77  
http://www.tec-it.com 
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3 Allgemein 

3.1 TBarCode OCX - Microsoft® ActiveX® konformes Strichcode-
Steuerelement 

Mit TBarCode OCX steht Anwendern ein professioneller Strichcode Generator zur Verfügung: 
TBarCode erzeugt und druckt mehr als 70 verschiedene Barcodevarianten (Symbologien) in 
perfekter Qualität.  

TBarCode OCX entspricht der Microsoft ActiveX Spezifikation und kann daher mit wenigen 
Mausklicks in einer großen Zahl von bekannten Softwareanwendungen eingebunden werden (z.B. 
Textverarbeitungen oder Entwicklungsumgebungen). 

TBarCode unterstützt alle gebräuchlichen Strichcodevarianten: Lineare Strichcodes wie z. B. Code 
2 aus 5, Code39, Code-128, EAN, UPC, Post-Codes werden genauso erzeugt wie 2D-Strichcodes 
mit hoher Datendichte wie z.B. PDF417, MaxiCode, Data Matrix, QR-Code und UCC/EAN 
Composite. 

3.2 Zweck dieses Dokuments 

Dieses Tutorial konzentriert sich auf die ersten Schritte mit TBarCode. Im besonderen wird auf die 
Verwendung von TBarCode OCX innerhalb von Microsoft Office und verbreiteten 
Entwicklungsumgebungen eingegangen. 

Für eine genaue Beschreibung der API von TBarCode (Programmierschnittstelle für Software-
entwickler) halten Sie sich bitte an die zusätzlich verfügbare Produkt-Dokumentation (siehe 
http://www.tec-it.com/Download/index_d.htm ► Barcode Software für Windows ► Dokumentation). 

� In diesem Dokument werden Office 2003 Anwendungen als Beispiel verwendet. TBarCode 
kann allerdings auch mit älteren bzw. neueren Office-Versionen verwendet werden. 

3.3 Installation 

Laden Sie das Produkt TBarCode OCX unter http://www.tec-it.com/Download/index_d.htm ► 
Barcode Software für Windows herunter. 

Führen Sie danach das Installationsprogramm aus. Das Installationsprogramm kopiert alle benötig-
ten Dateien in das gewünschte Verzeichnis und registriert das ActiveX Steuerelement im System.  

Nach der Installation kann das ActiveX Steuerelement TBarCode OCX in beliebigen Anwendungen 
verwendet werden. 

3.4 Registrierung im System 

Ein ActiveX Steuerelement muss (im Gegensatz zu „normalen“ Programmen) im Betriebssystem 
registriert werden. Erst dann kann ein anderes Programm das ActiveX Control benutzen. Diese 
Registrierung ist nicht mit einer Bekanntgabe Ihrer persönlichen Daten (z.B. über Internet) zu 
verwechseln. 

� Die Registrierung eines ActiveX Steuerelementes im System wird vom 
Installationsprogramm automatisch durchgeführt.  
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� Wenn TBarCode OCX ohne die Verwendung des Installationsprogramms installiert werden 
soll, dann muss das Steuerelement manuell registriert werden. Verwenden Sie dazu das 
Werkzeug "REGSVR32.EXE" welches Teil des entsprechenden Microsoft-Betriebssystems 
ist (oder auch bei Entwicklungsumgebungen mitgeliefert wird). 

� Ohne Registrierung kann TBarCode OCX nicht verwendet werden.  

3.5 Lizensierung 

TBarCode ist in verschiedenen Lizenzvarianten erhältlich. Folgende Lizenzen stehen zur Auswahl: 

� Einzellizenz für genau einen Computer 
� Standortlizenz für bis zu 250 Installationen innerhalb eines Unternehmensstandortes 
� Entwicklerlizenz für die Einbettung von TBarCode in eigene Applikationen (bis zu 10000 

Redistributionen bzw. Benutzer) 
� Web-Lizenzen für den Einsatz von TBarCode auf Web-Servern 
 

� Sie laden TBarCode OCX immer als Demo-Version vom Internet. Die Demo-Version wird 
mit dem Eingeben eines Lizenzschlüssels (der bei TEC-IT bestellt werden kann) zu einer 
Vollversion aufgewertet.  

� TBarCode OCX kann ohne Lizenzierung für Evaluierungszwecke verwendet werden (siehe 
Einschränkungen der Demo Version).  

3.6 Verteilung an Dritte als Teil Ihrer Anwendung 

Wenn Sie eigene Softwarepakete, in denen TBarCode eingebettet ist, an Dritte verteilen oder 
verkaufen wollen, dann benötigen Sie eine Entwicklerlizenz. 

Stellen Sie sicher, dass TBarCode innerhalb Ihrer Applikation auf jedem Zielrechner lizenziert wird. 
Rufen Sie dazu die Lizenzierungsmethode von TBarCode mit dem Ihnen zugeteilten 
Lizenzschlüssel am Beginn Ihrer Applikation auf.  

ActiveX Steuerelemente müssen im Betriebssystem registriert werden. Wenn Sie 
Installationswerkzeuge (z.B. InstallShield) verwenden, markieren Sie das TBarCode OCX einfach 
als "self-registering" den Rest übernimmt das Setup. Außerdem steht Ihnen auch die Möglichkeit 
offen, TBarCode mittels "REGSVR32.EXE" zu registrieren (REGSVR32 ist ein Werkzeug von 
Microsoft; stellen Sie sicher, dass es auf der Zielhardware verfügbar ist). Ohne Registrierung des 
Steuerelementes im System kann TBarCode OCX nicht verwendet werden! 

3.7 Einschränkungen der Demo Version 

Alle mit TBarCode erzeugten Strichcodes werden mit einem Demo-Hinweis ausgedruckt. Der 
Strichcode selbst bleibt im Normalfall lesbar – und ist auch korrekt. 

3.7.1.1 Temporärer Lizenzschlüssel 

Bei besonders kleinen Strichcodes kann der Demotext beim Testen stören - in diesem Fall können 
Sie einen zeitlich befristeten Lizenzschlüssel anfordern (formlos per Email an sales@tec-it.com). 

3.7.1.2 Ablauf nach 90 Tagen 

Wenn die Software nicht lizensiert wird, kann nach 90 Tagen (ab Installation) die Barcode-
Generierung deaktiviert werden. Das Eingeben eines Lizenzschlüssels schaltet die Software frei. 
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3.8 Beispielanwendungen 

TEC-IT stellt Ihnen eine Reihe von Beispielanwendungen (mit Quell-Code) zur Verfügung. Sie 
finden diese unter http://www.tec-it.com/Download/index_d.htm ► Barcode Software für Windows 
► Beispielcode! 

� Installieren Sie TBarCode bevor Sie die Beispielanwendungen ausprobieren! Ohne instal-
liertem TBarCode OCX funktionieren die Beispielanwendungen nicht.  

3.9 Zusätzliche Dokumentation 

Die detaillierte Produktbeschreibung steht in separaten Dokumenten zur Verfügung. Sie finden 
diese im Web unter http://www.tec-it.com/Download/index_d.htm ► Barcode Software für Windows 
► Dokumentation. 
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4 Begriffsdefinitionen 

4.1 ActiveX  

ActiveX Steuerelemente werden manchmal auch als Objekt, Control, Plug-In, OLE oder COM 
Komponente bezeichnet. 

Ein ActiveX Steuerelement ist ein Stück Programmlogik (in unserem Fall das Erzeugen und 
Drucken von Barcodes), welches nach Belieben in Anwendungen eingefügt werden kann. Solche 
Anwendungen werden Container-Anwendungen genannt und müssen die ActiveX Technologie von 
Microsoft unterstützen.  

Der Inhalt des Steuerelements kann dabei beliebig verändert und zusammen mit dem übrigen 
Dokumentinhalt verwendet (ausgedruckt, etc) werden.  

ActiveX Controls (oder OLE Controls) können in zahlreichen Windows-Programmen verwendet 
werden, z. B. in allen Microsoft Office Anwendungen. Auch die Mehrzahl der heute in Verwendung 
befindlichen Entwicklungsumgebungen (z.B. Visual Basic®, Visual Studio® C/C++, C#, .NET, 
Borland C++ Builder, Borland Delphi) oder auch Programmiersprachen (inklusive von Web-
Technologien wie ASP oder PHP) unterstützen die ActiveX Technologie.  

Weiters unterstützen Steuerelemente zumeist "Data-Binding", d.h. der Inhalt des Steuerelements 
wird an eine Zelle in der Tabellenkalkulation oder an ein Datenfeld in einem Datenbank-Report 
„gebunden“. Ändert sich der Wert der Zelle oder des Datenfeldes, wird auch der Inhalt des 
Steuerelementes automatisch aktualisiert. Dadurch werden ActiveX Elemente sehr flexibel 
einsetzbar. 

Ein ActiveX Steuerelement kann mittels Scripting (JavaScript, VBScript) oder Programmierung 
(VBA, Visual Basic, C/C++, C#...) gesteuert werden. In vielen Anwendungen ist aber auch die 
Kontrolle des Steuerelementes durch den Benutzer selbst (ohne Programmierung) möglich. 

In diesem Dokument bezieht sich der Begriff ActiveX immer auf TBarCode OCX. Allerdings ist die 
prinzipielle Verwendung eines ActiveX Steuerelementes immer gleich. D.h. auch andere TEC-IT 
ActiveX Conrols wie TConnector oder TFORMer Runtime werden ähnlich verwendet.  

4.2 Container-Anwendungen 

Ein ActiveX Steuerelement ist eine Softwarekomponente, die nur im Zusammenspiel mit einer 
Container-Anwendung verwendet werden kann. Es wertet die Container-Anwendungen um die 
entsprechende Funktionalität auf. 

Das Verhalten eines Steuerelementes kann auf verschiedene Arten gesteuert werden: 

� Direkt 
…durch das manuelle Einstellen der Eigenschaften des Steuerelementes durch den 
Endbenutzer. Das Verhalten eines Steuerelementes kann durch Eigenschaften kontrolliert 
werden (z.B. welcher Barcodetyp wird benötigt). Dazu reicht in den meisten Fällen ein 
Rechtsklick mit der Maus auf das Objekt – es ist keine Programmierung nötig. 

� Scripting 
In Microsoft-Anwendungen kann ein ActiveX Control auch mittels VBA (Visual Basic for 
Applications) angesprochen werden. Manchmal steht auch JavaScript oder VBScript zur 
Verfügung. 

� Programmierung 
Alle gängigen Programmiersprachen haben die Möglichkeit, ActiveX-Controls einzubetten 
(wie Visual Basic, C, C++, C#, Pascal, Cobol, RPG, …). Hier steht dem Entwickler die 
größtmögliche Flexibilität zur Verfügung. 
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4.3 Symbologie (Barcode-Typ) 

Der Begriff Symbologie steht für die Variante des zu erzeugenden Barcodes. TBarCode unterstützt 
mehr als 70 verschiedene Varianten (z. B. Code 2 aus 5 interleaved, Code128, PDF417, Data 
Matrix). Jede Symbologie besitzt verschiedene Vor- und Nachteile wie z. B. Datenkapazität, 
kodierbare Zeichen, Platzverbrauch (Datendichte) usw. 

4.4 Kodierung 

Der Begriff Kodierung beschreibt den Umwandlungsprozess von beliebigen Daten in das 
entsprechende Barcodemuster. 

4.5 Data Binding 

Mit Data-Binding wird die Fähigkeit bezeichnet, ein Steuerelement wie TBarCode an beliebige 
Datenfelder der Container-Anwendung zu binden. Ändert sich das zugrunde liegende Datenfeld, 
dann ändert sich automatisch der zu erzeugende Barcode. Alle anderen Einstellungen (z.B. die 
Barcode-Symbologie) bleiben unverändert. 

Data-binding ist in Anwendungen wie Microsoft Access oder Microsoft Excel® sehr nützlich. Das 
Barcode-Control wird in den entsprechenden Bericht oder die entsprechend Tabelle eingefügt. Die 
Daten werden automatisch aus der zugrunde liegenden Tabellenzelle (oder Datenbankspalte) für 
eine Codierung als Barcode herangezogen.  

� Hinweis: Nicht alle Anwendungen unterstützen Data-Binding. Manchmal kann Data-Binding 
durch intelligentes Scripting nachgebildet werden - unser Support hilft Ihnen gerne 
(mailto:support@tec-it.com). 
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5 Verwendung Allgemein 

5.1 Allgemein 

ActiveX Steuerelemente (wie TBarCode, TConnector, TFORMer Runtime…) können in allen 
Programmen verwendet werden, die mit ActiveX-Steuerelementen umgehen können. Das bedeutet, 
dass Sie ActiveX Controls von TEC-IT in fast jedes am Markt etablierte Programm einbinden 
können. 

� Nachfolgend beschreiben wir das Arbeiten mit ActiveX Steuerelementen anhand des 
Produktes TBarCode OCX (Microsoft ActiveX konformes Barcode Steuerelement). Die 
allgemeinen Hinweise sind aber auch für andere ActiveX-Steuerelemente von TEC-IT gültig. 

5.1.1 Einfügen eines ActiveX Steuerelementes 

Details zum Einfügen von TBarCode OCX in eine bestimmte Applikation finden Sie in den 
nachfolgenden Kapiteln. Die generelle Vorgehensweise zum Einfügen von Steuerelementen sei 
hier kurz angeführt: 

� Wähle Objekt einfügen oder ActiveX-Control einfügen. 
� Aus der Liste TBarCode auswählen. 
� Das Steuerelement einfügen. 
� Die genauen Abmessungen festlegen (durch Ziehen mit der Maus). 
� Die Eigenschaften des Steuerelementes auf die gewünschten Werte einstellen (rechter 

Mausklick ► Eigenschaften). 
 

� Je nach Applikation muss man sich im Design- oder Bearbeitungsmodus befinden, um 
ActiveX Steuerelemente einfügen zu können. 

� Oftmals werden Steuerelemente auch über eine sogenannte "Toolbox" eingefügt. 

� In manchen Anwendungen muss zuerst ein sogenannter "OLE Container" eingefügt werden, 
in den dann das TBarCode Steuerelement platziert werden kann. 

� Makros müssen aktiviert/enabled sein (Sicherheitseinstellungen in Microsoft Excel / Word). 
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6 Verwendung in Microsoft Office Anwendungen 

6.1 Barcodes in Microsoft Word 

6.1.1 Einfügen von TBarCode in ein Dokument 

Um TBarCode OCX in ein Microsoft Word Dokument zu verwenden, führen Sie folgende Schritte 
durch: 

� Öffnen oder erstellen Sie ein Dokument. 
� Wählen Sie im Menü den Eintrag Einfügen ► Objekt…(�). 
� Wählen Sie TBarCode von der Objekttypliste � und betätigen Sie mit OK. 
� Um die Eigenschaften zu setzen, klicken Sie mit der rechten Maustaste auf das Objekt �. 
� Wählen Sie TBarCode-Objekt ► Properties (siehe Abbildung 2 auf Seite 12, �). 
� Das Eigenschaftsfenster � wird geöffnet. Informationen zu den Einstellungsmöglichkeiten 

(Strichcode-Parameter) finden Sie in der Produktdokumentation von TBarCode OCX. 
 

 
Abbildung 1: Verwendung von TBarCode in Microsoft Word (1) 

� 

� 

� 
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Abbildung 2: Verwendung von TBarCode in Microsoft Word (2) 

� 

� 
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6.1.2 TBarCode mit VBA (Visual Basic for Applications) verwenden 

Wollen Sie das TBarCode OCX in VBA „skripten“, also per VBA Programm darauf zugreifen, führen 
Sie folgende Schritte aus: 

� Öffnen oder erstellen Sie ein Dokument. 
� Wenn die Steuerleiste für Visual Basic � nicht sichtbar ist, klicken Sie mit der rechten 

Maustaste auf die obere Menüleiste und wählen Sie Visual Basic. 
� Wenn die Steuerelement-Toolbox � nicht sichtbar ist, blenden Sie diese ein (Rechts-Klick 

auf die obere Menüleiste, wählen Sie Steuerelement-Toolbox). 
� In der Toolbox (�) wählen Sie das Symbol Weitere Steuerelemente � und selektieren Sie 

anschließend TBarCode in Liste �. Das TBarCode Steuerelement wird eingefügt. 
� Um die Eigenschaften des Steuerelementes zu ändern, klicken Sie auf das Eigenschaften 

Symbol 	 in der Steuerelement-Toolbox. Ein Fenster mit “Eigenschaft:Wert” Paaren (
) 
erscheint. 

� Wenn Sie das Steuerelement doppelklicken, können Sie ereignisgesteuerten VBA-Code 
editieren (nicht gezeigt). 

 

 
Abbildung 3: Verwendung von TBarCode 

� 

� 

� 

� 

� 
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6.1.3 TBarCode OCX per Code einfügen (VBA) 

Der angeführte Beispielcode zeigt Ihnen, wie Sie ein TBarCode Objekt mit VBA Programmcode in 
ein Word Dokument an die aktuelle Cursorposition einfügen. 

Dieser Programmcode fügt einen Strichcode an die aktuelle Cursorposition ein. Als Codetyp 
wird „Code-128“ und als Dateninhalt wird „1234567890“ eingestellt. 

Dim oShape As InlineShape 
Dim oTBC As Object 

Ein Word Inline Shape mit einem OLE Objekt „TBarCode6“ wird an die aktuelle Cursor -
Position eingefügt: 

Set oShape = Selection.InlineShapes.AddOLEObject(ClassType:="TBarCode6.TBarCode6.1", _ 
  FileName:="", LinkToFile:=False, DisplayAsIcon:=False) 
 
oShape.OLEFormat.Activate 

Durch die Grösseneinstellung des „Shapes“ legen wir auch die Strichcode-Grösse fest. 

oShape.Width = 200 
oShape.Height = 100 

Für den einfacheren Zugriff verbinden wir die Variable oTBC mit dem TBarCode Objekt im 
eingefügten Shape. 

Set oTBC = oShape.OLEFormat.Object 

Über den Zugriff auf das Barcode Objekt „oTBC“ können wir die Strichcode-Eigenschaften wie 
Barcodetyp und Dateninhalt anpassen. 

oTBC.Barcode = 20  '20 = Code-128 (siehe Barcode-Referenz) 
oTBC.Text = "1234567890" 

6.1.4 Serienbriefe 

Um das TBarCode Objekt in Serienbriefen zu verwenden stellt TEC-IT ein Makro im Download-
bereich http://www.tec-it.com/Download/index_d.htm ► Barcode Software für Windows ► Beispiel-
code zur Verfügung. 

Nach dem Erzeugen des Serienbriefes können Sie mit dem Makro jenes Datenfeld, welches als 
Barcode ausgegeben werden soll, in den Barcode transferieren – als Ausgangsbasis benötigen Sie 
nur ein leeres Barcode-Objekt in der Mustervorlage. 



 
 

Seite 15 von 42 

TBarCode OCX Tutorial  

6.2 Barcodes in Microsoft Excel 

6.2.1 Einfügen von TBarCode in ein Excel Arbeitsblatt 

Um TBarCode in Microsoft Excel zu verwenden, führen Sie bitte folgende Schritte aus: 

� Öffnen oder erstellen Sie ein Dokument. 
� Wählen Sie im Menü den Eintrag Einfügen ► Objekt…(�). 
� Wählen Sie TBarCode in der Objekttypliste � und betätigen Sie mit OK. 
� Wechseln Sie in den Entwurfsmodus (Dreieck-Symbol auf der Steuerelement-Toolbox �). 

Sollte die Steuerelement-Toolbox nicht sichtbar sein, dann kann sie durch rechten Mausklick 
auf die obere Menüleiste eingeblendet werden. 

� Um die Eigenschaften zu setzen, klicken Sie mit der rechten Maustaste auf das TBarCode 
Objekt und wählen Sie TBarCode-Objekt ► Properties (�). 

� Das Eigenschaftsfenster � wird geöffnet. (Für Informationen zu den Einstellungsmöglich-
keiten halten Sie sich bitte an die Produktdokumentation von TBarCode OCX). 

  

 
Abbildung 4: Verwendung von TBarCode in Microsoft Excel 
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6.2.2 TBarCode mit VBA (Visual Basic for Applications) verwenden 

Wenn Sie TBarCode in VBA „scripten“ wollen, führen Sie bitte folgende Schritte aus: 

� Öffnen oder erstellen Sie ein Dokument. 
� Wenn die Steuerleiste für Visual Basic � nicht sichtbar ist, klicken Sie mit der rechten Maus-

taste auf die obere Menüleiste und wählen Sie Visual Basic. 
� Wenn die Steuerelement-Toolbox � nicht sichtbar ist, blenden Sie diese ein (Rechts-Klick 

auf die obere Menüleiste, wählen Sie Steuerelement-Toolbox). 
� In der Toolbox (�) wählen Sie das Symbol Weitere Steuerelemente � und selektieren Sie 

anschließend TBarCode in Liste �. 
� Bewegen Sie den Mauszeiger an die gewünschte Position und klicken Sie mit der linken 

Maustaste. Das TBarCode Steuerelement � wird eingefügt. 
� Um die Eigenschaften des Steuerelementes zu ändern, klicken Sie auf das Eigenschaften 

Symbol 	 in der Steuerelement-Toolbox. Ein Fenster mit “Eigenschaft:Wert” Paaren (
) 
erscheint. 

� TBarCode kann nun in VBA verwendet werden. Verwenden Sie dazu den Objektnamen, der 
im Eigenschaftsfenster angezeigt wird. 

 

 
Abbildung 5: Verwendung von TBarCode in Microsoft Excel mit VBA 

� 

� 

� 

� 

� 

	 


 



 
 

Seite 17 von 42 

TBarCode OCX Tutorial  

6.2.3 Verbundene Zellen (Data Binding) 

Neben der Programmierung von TBarCode mit VBA (Visual Basic for Applications) steht Ihnen 
auch noch eine Standard-Eigenschaft von Excel für das Setzen des Barcode-Inhalts zur Verfügung 
– die Eigenschaft LinkedCell. Dabei wird die angegebene Zelle als Datenquelle für den Barcode 
verwendet – jede Änderung des Zelleninhaltes bewirkt eine sofortige Aktualisierung des Barcodes. 

� Selektieren Sei den Barcode � durch Mausklick, nachdem TBarCode – wie oben beschrie-
ben – in das Dokument eingefügt wurde. 

� Klicken Sie auf das Eigenschaften Symbol � in der Steuerelement-Toolbox. 
� Geben Sie die zu verwendende Zelle (hier B29) im Eigenschaftsfenster � ein. 
� Der Barcode wird nun mit jeder Änderung der Zelle B29 aktualisiert. 

 

 
Abbildung 6: Verwendung von TBarCode in Microsoft Excel (Data Binding) 
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6.2.4 TBarCode per Code (VBA) einfügen 

Der angeführte Beispielcode zeigt Ihnen, wie Sie ein TBarCode Objekt mit VBA Programmcode in 
ein Excel Arbeitsblatt an eine bestimmte Position einfügen. 

Dim TargetCell As Variant     ' Die Zelle, in die der Strichcode eingefügt werden soll 
Dim CellHeight As Variant     ' Höhe der Zelle 
Dim CellWidth  As Variant     ' Breite der Zelle 
Dim CellTop    As Variant     ' Obere Rand-Koordinate der Zelle 
Dim CellLeft   As Variant     ' Linke Rand-Koordinate der Zelle 
Dim BCObject   As OLEObject   ' Das TBarCode Container Objekt 
 
Als „Ziel-Zelle“ wählen wir C3 - dort soll der Strichcode eingefügt werden. 
TargetCell = "C3" 
 
Ist die Zelle zu klein, passen wir die Höhe an eine Mindesthöhe an: 
If (Range(TargetCell).RowHeight < 30) Then 
  Range(TargetCell).RowHeight = 30 
End If 
 
Lese nun die Zellengrösse aus 
CellHeight = Range(TargetCell).Height 
CellWidth = Range(TargetCell).Width 
CellTop = Range(TargetCell).Top 
CellLeft = Range(TargetCell).Left 
 
Füge das TBarCode Objekt an die ausgelesene Position ein. 
Set BCObject = ActiveSheet.OLEObjects.Add(ClassType:="TBARCODE6.TBarCode6.1", _ 
  Left:=CellLeft, _ 
  Top:=CellTop, _ 
  Width:=CellWidth, _ 
  Height:=CellHeight) 
   
Über „BCObject.Object“ erhalten wir Zugriff auf das TBarCode Objekt. Wir stellen den 
Dateninhalt, den Barcodetyp und die Schriftgrösse ein. 
BCObject.Object.Text = "123456" 
BCObject.Object.Barcode = 20  ' 20 = Code-128 (siehe Strichcode-Referenz) 
BCObject.Object.FontSize = 8 

Sie können den obigen VBA Code per Makro oder per Kommando-Schaltfläche ausführen. 

 
Figure 1: TBarCode per Code (VBA) in Excel einfügen 
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6.3 Barcodes in Microsoft Access 

TBarCode kann in Microsoft Access Formularen oder Berichten verwendet werden. 
Datenbankspalten werden dabei von TBarCode direkt kodiert. Natürlich ist auch die Angabe von 
Formeln, Berechnungen oder fixen Werten als Barcodeinhalt möglich.  

6.3.1 Einfügen von TBarCode in eine Microsoft Access Datenbank (Bericht) 

Um TBarCode in einen Bericht einfügen, gehen Sie bitte wie folgt vor: 

� Öffnen oder erstellen Sie Ihren Bericht (bzw. Formular) im Entwurfsmodus. (Fenster � muss 
sichtbar sein). 

� Wählen Sie Einfügen ► ActiveX-Steuerelement… aus dem Menü aus (�). Alternativ dazu 
können Sie auch die Schaltfläche Weitere Steuerelemente � in der Toolbox anklicken. 
(Sollte die Steuerelement-Toolbox nicht sichtbar sein, dann klicken Sie mit der rechten 
Maustaste in den Symbolleisten-Bereich � und wählen sie Toolbox). 

� Wählen Sie TBarCode in der Objekttypliste � und bestätigen Sie mit OK. 
� Positionieren Sie den Mauszeiger an der Stelle im Bericht (bzw. im Formular), an der Sie 

das Objekt platzieren möchten, und klicken Sie die linke Maustaste. TBarCode wird einge-
fügt (�). 

� Um die Eigenschaften zu setzen, klicken Sie mit der rechten Maustaste auf das TBarCode 
Objekt und wählen Sie TBarCode-Objekt ► Eigenschaften (bzw. einfach nur Eigenschaf-
ten). Das Eigenschaftsfenster 	 wird geöffnet. 

 

 
Abbildung 7: Verwendung von TBarCode in Microsoft Access 
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6.3.2 Daten binden (Data Binding) 

In Berichten und Formularen kann der Barcode-Inhalt an ein Datenfeld gebunden werden. Er ändert 
sich dann dynamisch mit dem jeweils angezeigten Datensatz. Führen Sie dazu folgende Schritte 
durch: 

� Klicken Sie TBarCode OCX � mit der rechten Maustaste an. 
� Im erscheinenden Menü wählen Sie Eigenschaften �. 
� Wählen Sie den Reiter Daten �. 
� Geben Sie das Datenfeld (oder den Ausdruck) an, das (der) als Datenquelle für den Bar-

code dienen soll (�). Dieser Schritt ist nur möglich wenn vorher für den gesamten Bericht 
eine Datenquelle festgelegt wurde. Dies ist durch Einstellung der Berichtseigenschaften 
möglich.  

 

 
Abbildung 8: Verwendung von TBarCode in Microsoft Access (Data Binding) 

� Bitte stellen Sie sicher, dass der eingestellte Barcodetyp zu den Daten passt. Nicht alle 
Barcodetypen können auch alphabetische Zeichen kodieren. – Sie erhalten in solchen 
Fällen eine Fehlermeldung anstatt des Barcodes. 

� Je nach Excel Version und den Einstellungen gibt es verschiedene Formate zur Angabe der 
„Linked Cell“. Deutsch: Z1S1 = Zeile 1, Spalte 1 (bedeutet dasselbe wie $A$1); English = 
R1C1 (Row/Col) 

� 

� 

� 

� 
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6.3.3 TBarCode in Access VBA (Visual Basic for Applications) 

Um TBarCode von VBA aus ansprechen zu können, führen Sie dieselben Schritte aus, wie oben 
beschrieben, jedoch: 

� Sprechen Sie die Eigenschaften des Barcode Objektes über den Access Eigenschaften-
Dialog an (siehe Abbildung 7, �). Nur in diesem Dialog können Sie den Objektnamen sowie 
den Steuerelementinhalt (Feldliste) erfassen. (Das Ansprechen von TBarCode über die 
produkteigenen „Property Pages“ ist natürlich trotzdem gestattet). 

� Zum Anzeigen der Eigenschaften betätigen Sie die Eigenschaften Schaltfläche in der 
Menüleiste oder wählen Sie nach einem Rechtsklick auf das Objekt den Menüeintrag 
Eigenschaften aus. 

Für die Programmierung des ActiveX Controls: Der Zugriff auf das interne ActiveX-Interface ist 
über das Object Tag möglich. Beispiel: TBarCode61.object.Text bietet Zugriff auf die Text-
Eigenschaft (jene Eigenschaft, die den Dateninhalt des Barcodes repräsentiert). 

TBarCode61.object.Text = "12345" 'Barcode Daten festlegen 
TBarCode61.object.Barcode = 20 'Barcode Symbologie = Code-128 festlegen 
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6.4 Barcodes in Microsoft InfoPath® 

Microsoft InfoPath kann mittels TBarCode OCX Barcodes verwenden. Da Microsoft InfoPath keine 
eingebauten „Eigenschaft:Wert“ Fenster für Steuerelemente anzeigt, müssen alle Barcode-Parame-
ter in den Eigenschaftsseiten von TBarCode OCX festgelegt werden. 

6.4.1 Vorbereiten von Microsoft InfoPath für TBarCode OCX 

Führen Sie folgende Schritte aus, wenn TBarCode OCX zuvor noch nie innerhalb von Microsoft 
InfoPath benutzt wurde: 

� Öffnen Sie ein Formular im Entwurfsmodus. 
� Aktivieren Sie den Aufgabenbereich. Dazu wählen Sie im Menü Ansicht ► Aufgabenbereich 

(�). Der Aufgabenbereich � erscheint. 
� Schalten Sie in die Ansicht der Steuerelemente �. 
 

 
Abbildung 9: Verwendung von TBarCode in Microsoft InfoPath (1) 
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� Klicken Sie auf Benutzerdefinierte Steuerelemente hinzufügen oder entfernen…(�) im 
unteren Teil des Aufgabenbereich-Fensters. 

� Microsoft InfoPath zeigt in einem Dialog eine Liste aller bereits installierten Steuerelemente 
an. Klicken Sie Hinzufügen… (�) um den „Assistenten zum Hinzufügen eines benutzerdefi-
nierten Steuerelementes“ zu starten. 

� Wählen Sie den Eintrag TBarCode aus der angezeigten Liste aus (	). 
 

 
Abbildung 10: Verwendung von TBarCode in Microsoft InfoPath (2) 
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� Klicken Sie Weiter bis die Seite „Legen Sie die zu bindende Eigenschaft fest“ angezeigt 
wird. WICHTIG: Wählen Sie in dieser Liste den Eintrag Text aus! 

� Klicken Sie Weiter und wählen Sie den Eintrag Enabled in der Seite „Eigenschaft für das 
Aktivieren und Deaktivieren festlegen“. 

� Klicken Sie Weiter und wählen Sie alle Datentypen (durch Anklicken jeder Zeile) in der Seite 
„Datentypoptionen festlegen“ aus. Der Standarddatentyp Text (string) sollte nicht verändert 
werden. Klicken Sie dann auf Fertig. 

       
Abbildung 11: Verwendung von TBarCode in Microsoft InfoPath (3) 

� Klicken Sie OK (�). 
� Das TBarCode Steuerelement wird nun im Aufgabenbereich-Fenster angezeigt (). 

 

 
Abbildung 12: Verwendung von TBarCode in Microsoft InfoPath (4) 


 � 
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6.4.2 Einfügen von TBarCode OCX in ein Microsoft InfoPath Dokument 

Nachdem TBarCode OCX zu den verfügbaren Steuerelementen hinzugefügt wurde, kann es in das 
Dokument eingefügt werden: 

� Ziehen Sie das TBarCode Steuerelement � mit der Maus aus dem Aufgabenbereich an die 
gewünschte Stelle im Formular. 

� Mit dem Loslassen der Maustaste erscheint der Dialog „Bindung für TBarCode“. 
� Legen Sie fest, welches InfoPath-Feld als Barcode dargestellt werden soll (�). 
� Klicken Sie OK. Ein Barcode wird in das Formular eingefügt. 

 

 
Abbildung 13: Verwendung von TBarCode in einem Microsoft InfoPath Dokument 
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6.4.3 Ändern der Barcode-Einstellungen in Microsoft InfoPath  

Zum Ändern des Barcodetyps führen Sie folgende Schritte aus (diese Vorgehensweise gilt für alle 
Barcode-relevanten Optionen):  

� Klicken Sie mit der rechten Maustaste auf den Barcode �. 
� Im erscheinenden Dialog wählen Sie Eigenschaften für TBarCode… �. 
� Aktivieren Sie den gewünschten Reiter (z.B. General �). 
� Selektieren Sie den gewünschten Barcode-Typ (�). 
� Klicken Sie OK. 
� TBarCode OCX bietet eine Fülle von Optionen und Eigenschaften. Für Informationen zu 

den Einstellungsmöglichkeiten halten Sie sich bitte an die zusätzlich verfügbare Produkt-
dokumentation zu TBarCode OCX. 

  

 
Abbildung 14: Ändern der TBarCode Einstellungen in einem Microsoft InfoPath Dokument 
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7 Verwendung in Entwicklungsumgebungen (IDE) 

TEC-IT ActiveX Controls (z.B. TBarCode, TConnector oder TFORMer Runtime) können 
problemlos in verschiedene Entwicklungsumgebungen eingebunden und angesprochen werden. Es 
können Instanzen des Objekts erzeugt, verändert und ausgedruckt werden. 

Wir empfehlen Ihnen, die Beispielanwendungen auf http://www.tec-it.com/Download/index_d.htm ► 
Barcode Software für Windows ► Beispielcode anzusehen. Die im Folgenden angeführten 
Beispiele gelten für TBarCode OCX und für andere ActiveX-Steuerelemente. 

7.1 Microsoft Visual Basic 

7.1.1 Verwendung von TBarCode in einem Visual Basic Projekt 

Um TBarCode in Visual Basic zu verwenden, führen Sie bitte folgende Schritte aus: 

� Öffnen oder erstellen Sie Ihr VB-Projekt. 
� Klicken Sie mit der rechten Maustaste auf die Toolbox und wählen Sie Components aus. 
� Wählen Sie TBarCode Type Library von der Liste (Insertable Objects) und bestätigen Sie mit 

OK. 
� Sie können TBarCode nun wie ein VB-Control in der Toolbox verwenden. 
� Die Eigenschaften des Barcodes können im VB-Eigenschaftsfenster („Properties 

TBarCode61“) geändert werden. 
� Falls Sie die TBarCode „Property Pages“ (anstatt des VB-Eigenschaftsfensters) 

bevorzugen, klicken Sie rechts auf das Objekt und wählen Sie Properties aus dem Popup-
Menü. (Für Details halten Sie sich bitte an die TBarCode Produktdokumentation). 

7.2 Microsoft Visual C++ 6.0 

7.2.1 Verwendung von TBarCode in einer MFC Applikation 

Um TBarCode in MFC zu verwenden, führen Sie bitte folgende Schritte aus: 

� Öffnen oder erstellen Sie eine MFC basierte Applikation. 
� Falls Sie ein neues Projekt erstellen, stellen Sie sicher, dass ActiveX Controls � auf Seite 3 

des „MFC AppWizard“ angehakt ist (Vorgabe). 

 
Abbildung 15: Verwendung von TBarCode in MSVC++ 6.0 (MFC Applikation) (1) 

� 
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� Wählen Sie im Menü Project ► Add to Project ► Components and Controls… 
� Wechseln Sie in den Ordner Registered ActiveX Controls. 
� Wählen Sie TBarCode aus der Liste aus und klicken Sie auf Insert. 
� Es wird automatisch eine Wrapper-Klasse für TBarCode wird automatisch generiert (�). 

Bestätigen Sie mit OK. 
 

 
Abbildung 16: Verwendung von TBarCode in MSVC++ 6.0 (MFC Applikation) (2) 

� Das Steuerelement ist nun in der Control Toolbox (im Dialog Editor) auswählbar (�). 
� Falls nötig verwenden sie den ClassWizard als Unterstützung. 
 

 
Abbildung 17: Verwendung von TBarCode in MSVC++ 6.0 (MFC Applikation) (3) 

7.2.2 Verwendung von TBarCode in einer Non-MFC Applikation 

Für nicht MFC Anwendungen empfehlen wie die Verwendung von TBarCode DLL. Beispiele finden 
Sie unter http://www.tec-it.com/Download/index_d.htm ► Barcode Software für Windows ► Bei-
spielcode. 
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7.3 Microsoft Visual Studio .NET 2003 

7.3.1 Verwendung von TBarCode als Steuerelement 

Um TBarCode in einer Visual Studio .NET Applikation in ein Formular einzubetten (z.B. in einer 
“Windows Applikation” oder in einer “ASP .NET Web Applikation”), führen Sie folgende Schrittte 
durch: 

� Öffnen oder erstellen Sie ein Projekt. 
� In der Toolbox wählen sie Components (�). 
� Klicken Sie mit der rechten Maustaste in die Toolbox und wählen Sie Add/Remove Items…. 

Ein Dialog erscheint. 
� In dem Dialog Wechseln Sie in den Reiter COM Components �. 
� Wählen Sie TBarCode � (machen Sie ein Häkchen in die Checkbox). 
� Bestätigen Sie mit OK (�). 
� TBarCode befindet sich nun in der Toolbox (�). 
� Um das Steuerelement zu verwenden, ziehen Sie es einfach von der Toolbox (�) auf das 

Formular (	). 
 

 
Abbildung 18: Verwendung von TBarCode in Visual Studio .Net 2003 (als Steuerelement) 

Mircosoft Visual Studio .NET erstellt automatisch eine Wrapper-Klasse für TBarCode. Das 
Steuerelement ist wie jedes andere ActiveX Control unter .NET verwendbar. 
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7.3.2 Verwendung von TBarCode als COM Objekt (Klasse) 

Um TBarCode per Code ansprechen zu können (ohne es als Steuerelement in ein Formular einzu-
betten), führen Sie bitte folgende Schritte durch: 

� Öffnen oder erstellen Sie ein Projekt. 
� Wählen Sie Project ► Add Reference… im Menü. 
� Im hochkommenden Dialog wechseln Sie in den Reiter COM (�). 
� Wählen Sie TBarCode aus der Liste aus und klicken Sie Select �. 
� Bestätigen sie mit OK (�). 
� TBARCODExLib befindet sich jetzt in den „References“ Ihres Projektes. (Es wird im 

“Solution Explorer” � angezeigt). 
� Die TBarCode Klasse kann jetzt in Ihrem Code verwendet werden. 

 

 
Abbildung 19: Verwendung von TBarCode in Visual Studio .Net 2003 (als Bibliothek) 

Beispiel für die Verwendung der TBarCode Klasse in C#: 

TBARCODE6Lib.TBarCode6Class obj = new TBARCODE6Lib.TBarCode6Class(); 
obj.BarCode = TBARCODE6Lib.tag_BarCType.eBC_2OF5IL; 
obj.Text = "12345"; 

� 

� 

� 
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7.4 Microsoft Visual Studio .NET 2005 

7.4.1 Verwendung von TBarCode als Steuerelement 

Um TBarCode in einer Visual Studio .NET Applikation in ein Formular einzubetten (z.B. in einer 
“Windows Applikation” oder in einer “ASP .NET Web Applikation”), führen Sie folgende Schrittte 
durch: 

� Öffnen oder erstellen Sie ein Projekt. 
� Klicken Sie mit der rechten Maustaste in die Toolbox � und wählen Sie Choose Items…. 

Ein Dialog erscheint. 
� Wechseln Sie in den Reiter COM Components �. 
� Wählen Sie TBarCode � (machen Sie ein Häkchen in die Checkbox). 
� Bestätigen Sie mit OK (�). 
� TBarCode befindet sich nun in der Toolbox (�). 
� Sie können das Steuerelement nun von der Toolbox (�) auf Ihr Formular (	) ziehen. 

 

 
Abbildung 20: Verwendung von TBarCode in Visual Studio .Net 2005 (als Steuerelement) 

Mircosoft Visual Studio .NET erstellt automatisch eine Wrapper-Klasse für TBarCode. Das Steuer-
element ist wie jedes andere ActiveX Control unter .NET verwendbar. 

7.4.2 Verwendung von TBarCode als Bibliothek 

Führen Sie die selben Schritte durch, wie in 7.3.2 beschrieben. 
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7.5 Microsoft Visual FoxPro 

7.5.1 Verwendung von TBarCode in einem Visual FoxPro Projekt 

Um TBarCode OCX in Visual FoxPro einzufügen, führen Sie folgende Schritte aus: 

� Öffnen oder erstellen Sie ein FoxPro-Projekt. 
� Öffnen oder erstellen Sie ein Formular. 
� Wählen Sie OLE-Container aus der Standard Toolbox. 
� Wenn Sie das Control zeichnen, öffnet sich ein Dialog „Insert Object“. Wählen Sie TBarCode 

(Insert Control) und bestätigen Sie mit OK. 
� Die Eigenschaften können im Eigenschaftsfenster geändert werden. 
� Falls Sie die TBarCode-eigenen Eigenschaftsfenster bevorzugen, klicken Sie rechts auf das 

Steuerelement und wählen Sie Properties aus dem Popup-Menü. 
� Im Project Manager können Sie das erstellte (und gespeicherte) Formular zum Projekt hin-

zufügen. 

7.5.2 Reports & Labels 

Wenn Sie Barcodes in Berichten oder Etiketten drucken wollen, benötigen Sie eine Tabelle mit 
einer definierten Spalte (Name z.B. „BC“), in der das TBarCode OCX als OLE-Control (Datentyp 
„General“) gespeichert sein muss. Dieses Datenfeld („BC“) muss zuvor mit der Datenstruktur eines 
Barcode-Objekts initialisiert werden. Dazu benötigen Sie eine Instanz eines TBarCode-Objekts als 
Vorlage (z. B. auf einem Formular, dieses Objekt kann auch unsichtbar sein). 

Visual FoxPro-Beispielcode für die Initialisierung der Datenfelder eines Barcode-Objekts: 

FOR n = 1 TO 10 
 INSERT INTO Table1 FROM MEMVAR 
 APPEND GENERAL Table1.BC CLASS TBarCode6.TBarCode6 
 WITH THISFORM.[Name of the TBarCode object instance] 
 .CONTROLSOURCE = "Table1.BC" 
 .REFRESH 
 .barcode = 20 && Barcode-Type = Code128 
 .TEXT = "000070000041" 
 .printdatatext = .T.  
 .BACKCOLOR = 16777215 
 .FORECOLOR = 0 && 16711680 -> (blue) 
 .REFRESH 
 ENDWITH 
NEXT 

Nachdem dieser Programmcode ausgeführt wurde, kann in das Report- oder Label-Formular ein 
OLE Picture/ActiveX Bound Control eingefügt werden. In unserem Beispiel muss als Datenherkunft 
(Field) „Table1.BC“ angegeben werden. 

� Wir verweisen hierzu auch auf unser FoxPro-Beispiel, welches auf der Downloadseite 
verfügbar ist: http://www.tec-it.com/Download/index_d.htm ► Barcode Software für 
Windows ► Beispielcode! 
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7.6 Microsoft Navision® 

Mit folgender Lösung können Sie in Navision einen Barcode generieren. 

Unter Navision kann TBarCode OCX nicht direkt in einen Report eingefügt werden. Es können 
jedoch Bitmap Dateien eingelesen werden, daher folgende Vorgangsweise. 

� Erzeugen oder öffnen Sie einen Report und fügen Sie eine Picture Box ein. 
� Erzeugen Sie ein Barcode Image, indem Sie das TBarCode OCX Steuerelement per Code 

aufrufen. 
� Laden Sie das Bild in die Picture Box. 

Beispiel-Code für die Erzeugung eines Barcode Images: 

COM objBC;     // Deklaration 
objBC = new COM("TBarCode6.TBarCode6.1"); // Instantiierung des COM Objektes „TBarCode6“ 
 
objBC.Text = "121212"  // Setzen der Barcode Daten 
objBC.Barcode = 20;  // 20 = Code-128 verwenden (siehe Barcode-Referenz) 
 
objBC.SaveImage(DateiNameBmp, 4, pxWidth, pxHeight, nXRes, nYRes); // als BMP speichern 

Für detailliertere Informationen, werfen Sie bitte einen Blick in unser Navision Tutorial, welches 
unter http://www.tec-it.com/Download/index_d.htm ► Barcode Software für Windows ► 
Beispielcode heruntergeladen werden kann. 

7.7 Microsoft Office / VBA 

Siehe Verwendung in Microsoft Office Anwendungen. 

7.8 Borland Delphi 

7.8.1 Verwendung von TBarCode in Borland Delphi 6/7 

Um TBarCode in Delphi 6/7 einzufügen, führen Sie folgende Schritte aus:  

� Wählen Sie im Menü Components ► Import ActiveX Control. 
� Wählen Sie TBarCode Type Library aus der Liste aus. 
� Betätigen Sie die Schaltfläche Install und bestätigen Sie die folgenden Abfragen mit OK. 

Das TBarCode-Steuerelement kann nun wie eine Standardkomponente (Toolbar ActiveX) 
verwendet werden. 

7.8.2 Verwendung von TBarCode in Borland Delphi 2005 (Delphi for Win32) 

Um TBarCode in Delphi 2005 einzufügen, führen Sie folgende Schritte aus:  
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7.8.2.1 Erstellen eines Pakets (Package) für TBarCode OCX 

Wählen Sie im Menü Datei ► Neu ► Paket – Delphi for Win32 (bzw. File ► New ► Package – 
Delphi for Win32): 

 

 

7.8.2.2 Speichern des Pakets (Package) 

Speichern Sie nun das Paket in 
einem eigenen Verzeichnis ab. 

 

Im Speichern Paket Als (Save Package As) Dialog wählen 
Sie zuerst das Verzeichnis (hier My Documents/Borland 
Studio Projects/TBarCode6) aus und geben anschließend 
den Namen des Developer Studio Projektes an (hier 
TBarCode6). 
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7.8.2.3 Einstellen der Projekt-Optionen 

Wählen Sie unter Projekt den Punkt Optionen… 
aus. 

 

Geben Sie nun in den Projekteigenschaften 
(Options) die Beschreibung des Paketes an. 

 

Nun müssen noch die Verzeichnisse angepasst werden. Wählen Sie dafür im Baum 
Directories/Conditionals aus. 

 

Als Ausgabeverzeichnis wählen Sie das Verzeichnis in das Sie Ihr Projekt gespeichert haben. 

7.8.2.4 TBarCode Komponent importieren  

Als nächster Schritt muss nun das TBarCode OCX importiert werden. Wählen Sie dafür im Menü 
Component ► Import Component… 
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Im Wizard wählen Sie Import ActiveX Control 
aus und klicken auf Weiter (Next). 

 

Auf der nächsten Wizardseite wählen Sie das 
TBarCode OCX aus. 

 

Klicken Sie auf Weiter (Next).  

Auf der nächsten Seite behalten Sie die 
Standardeinstellungen bei. 

 

Mit Weiter (Next) gelangen Sie nun auf die letzte 
Seite des Wizards. 

Hier wählen Sie nun aus, dass eine neue Unit 
angelegt werden soll. 

 

Klicken Sie auf Fertigstellen (Finish) um den Wizard abzuschließen. Im Hauptfenster von Delphi ist 
nun TBARCODE6Lib_TLB geöffnet. Speichern Sie diese Unit in das selbe Verzeichnis, in das Sie 
das Package-Projekt abgespeichert haben. 

7.8.2.5 Komponenten zu dem Paket hinzufügen 

Als nächstes muss TBarCode OCX zu Ihrem 
Paket hinzugefügt werden. 

Wählen Sie dazu im Menü Project den 
Eintrag Add to Project… aus. 

 

Unter Add Unit geben Sie nun die abgespeicherte 
TBARCODE6Lib_TLB.PAS an. 

 

 

Verwenden Sie Browse um die Datei auszuwählen. Wählen Sie OK um TBarCode hinzuzufügen. 
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7.8.2.6 Package erstellen und installieren 

Als nächstes muss das Package erstellt 
werden.  

Wählen Sie dafür unter Project den 
Eintrag Build <ProjectName> (im 
Beispiel: Build TBarCode6) 

 

 

Im nächsten Schritt muss das erstellte 
Package installiert werden.  

Wählen Sie dazu im Menü Component 
den Eintrag Install Packages aus. 

 
 

Fügen Sie nun das erstellte TBarCode 
OCX Package hinzu. Klicken Sie dafür 
auf Add. 

 

Wählen Sie nun das erstellte Package 
(hier TBarCode6.BPL) aus. 

Das gewählte Package (TBarCode6) 
wird nun in der Liste der Design 
Packages angezeigt. Klicken Sie auf 
OK um das Installieren abzuschließen. 
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7.8.2.7 Erstellen einer neuen VCL Forms Applikation 

Erstellen Sie nun eine neue VCL Forms 
Applikation.  

Wählen Sie hierfür unter File ► New ► VCL 
Forms Application … 

 

In der Tool Palette finden Sie nun eine neue 
Kategorie ActiveX.  

In diese Kategorie wurde TBarCode OCX 
eingefügt und kann nun in Ihrer Applikation 
verwendet werden. 

 

7.9 Borland C++ Builder 

7.9.1 Verwendung von TBarCode in Borland C++ 

Um TBarCode in C++ Builder einzufügen, führen Sie folgende Schritte aus:  

� Wählen Sie im Menü Components ► Import ActiveX Control. 
� Wählen Sie TBarCode Type Library aus der Liste aus. 
� Betätigen Sie die Schaltfläche Install und bestätigen Sie die folgenden Abfragen mit OK. 

Das TBarCode-Steuerelement kann nun wie eine Standardkomponente (Toolbar ActiveX) 
verwendet werden. 

7.10 Sybase PowerBuilder 

7.10.1 Verwendung von TBarCode mit PowerBuilder 

Um TBarCode in PowerBuilder einzufügen, führen Sie folgende Schritte aus:  

� Wählen Sie Controls ► OLE im Menü. 
� Wechseln Sie zur Seite Insert Control (PB10). 
� Wählen Sie TBarCode aus der Liste aus. 
� Bei Bedarf können die Barcode Einstellungen über das Kontext-Menü (OCX-Properties) 

editiert werden. 
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� In PowerBuilder Version 7, 8, 9 und 10 fügen Sie TBarCode immer mit Insert Control ein 
(Create New funktioniert nur teilweise). 

 

 
Abbildung 21: Verwendung von TBarCode in PowerBuilder 

7.10.2 DataWindows / Band Layer 

Gemäß unserer Tests ist die Verwendung von ActiveX Controls in PowerBuilder Version 7-10 nicht 
bzw. nur eingeschränkt möglich (TBarCode, aber auch andere Produkte), sobald in DataWindows 
das Control an einen Band Layer gebunden wurde. 

7.10.3 Scripting des Steuerelementes mit PowerBuilder 10 

Um die Eigenschaften und Methoden des ActiveX Controls anzusprechen, verwenden Sie diese 
Syntax:  

ControlName.Object.Property  

Beispiel: 

ole_1.object.text = "hello" 
ole_1.object.barcode = 20  ' 20 = Code 128 

 

� Die Symbologie (Barcode Type) wird durch Zuweisung der entsprechenden Nummer an die 
„Barcode“ Eigenschaft ausgewählt. Die verfügbaren Symbologien finden Sie in der 
„Strichcode Referenz“ (download unter http://www.tec-it.com/Download/index_d.htm ► Bar-
code Software für Windows ► Dokumentation). 
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7.11 Oracle Forms / Oracle Reports 

7.11.1 TBarCode OCX in eine Form einfügen 

Um ein ActiveX Control in eine „Oracle Form“ einzufügen, führen Sie bitte folgende Schritte durch: 

� Generieren oder Öffnen Sie eine neues Formular. 
� Im Layout Editor:  

a)  Zeichnen Sie ein ActiveX Control. 
b)  Klicken Sie mit der rechten Maustaste auf das Objekt und wählen Sie Insert Object. 
c)  Selektieren Sie das TBarCode Steuerelement. 

� Wählen Sie Menu ► Program OLE Importer and importieren Sie das Control. 

Optional: 

� Erweitern Sie die Form mit einer Schaltfläche und einem when-button-pressed Trigger im 
Canvas. Im Trigger Event Code können Sie z.B. ActiveX Control Properties verändern, usw. 

� Schließen sie den Layout Editor (Sehr wichtig!). 
� Starten Sie die Form. 
� Klicken Sie auf die Schaltfläche, um das Verhalten des ActiveX Controls zu testen. 

7.11.2 TBarCode OCX in einen Report einfügen 

Oracle Reports unterstützen bis auf weiteres keine ActiveX Controls, es gibt jedoch die Möglichkeit, 
per Kommandozeilen-Aufruf Strichcodes zu generieren. Folgende Vorgangsweise: 

Sie können eine ausführbare Datei (*.exe) innerhalb eines Reports aufrufen (im Before Report 
Trigger). So können Sie z.B. Barcode-Bitmaps (BMP Dateien) mit TEC-IT Barcode Studio 
generieren. Das Barcode Studio kann im Command Line Mode völlig unsichtbar arbeiten. Danach 
können Sie diese Bitmap Dateien einlesen und bestehenden Bild-Elementen im Report 
(Pictures/Images) zuweisen. TEC-IT Barcode Studio steht Ihnen im Downloadbereich von www.tec-
it.com zur Verfügung. 

Alternative: 

Wenn Sie TFORMer Runtime verwenden möchten, z.B. um einen Print-Job zu konfigurieren und 
zu starten, dann ist das mit dem Command Line Tool TFPrint.exe möglich. 

TFORMer ist ein komplettes Reporting-Werkzeug mit einem eingebauten Barcodegenerator. Mit 
TFORMer Designer werden Berichte entworfen, die später mit TFORMer Runtime (mittels 
tfprint.exe) ausgegeben werden. Die Ausgabe ist auf Druckern, als Postscript-Datei, als PDF-Datei 
oder als HTML möglich. 
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8 Eigenschaftsdialog von TBarCode OCX 

8.1 Aufruf 

In den meisten Windows-Programmen kann mit einem rechten Mausklick auf das ActiveX-
Steuerelement der Inhalt und die Formatierung des Barcodes verändert werden. Nachdem Sie mit 
der rechten Maustaste auf das Steuerelement geklickt haben, erscheint ein Kontext-Menü. Wählen 
Sie den Eintrag TBarCode-Object ► Properties, um Zugriff auf die Eigenschaften des Steuerele-
mentes zu erhalten. Es erscheint ein Eigenschaftsdialog („Property Pages“). 

Diese Property Pages werden in der getrennt erhältlichen Produktdokumentation beschrieben. 

� In Microsoft Office Anwendungen gibt es auch zusätzlich den Menüpunkt Eigenschaften 
oder Properties (nicht TBarCode-Object ► Properties, einfach nur Eigenschaften bzw. 
Properties!). Über diesen Menüpunkt können alle Eigenschaften des Steuerelements in 
einer Liste von Wertepaaren verändert werden. Bestimmte Eigenschaften – insbesondere 
das Data Binding – können nur in diesem Dialog eingestellt werden (und nicht in den 
„Property Pages“). 
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9 Kontakt und Support Information 

 
TEC-IT Datenverarbeitung GmbH 
 
Adresse: Wagnerstr. 6  

AT-4400 Steyr  
Austria/Europe 

Telefon: +43 / (0)7252 / 72 72 0 

Fax: +43 / (0)7252 / 72 72 0 – 77 

Email: mailto:support@tec-it.com 

Web: http://www.tec-it.com 
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